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eNsite Pro: A Guided Tour
In talking with customers using text-based versions of the DDMS software
about our eNsite Pro™ graphical product, we’ve heard some interesting
things. It seems there are a lot of misconceptions about the software and its ca-
pabilities. We’d like to set the record straight and offer some good reasons
why, if you aren’t already using the graphical software, you should be.

Speed
Users tell us they’re hesitant to move to graphical because they have heard
about speed issues. Is there any truth to it? Yes, there were issues—primarily
in order entry and earlier in the development cycle. In response to user feed-
back, our programming department put a lot of effort into optimizing, not just
order entry, but all of the graphical applications. The result was performance
improvements throughout the system, especially order entry. If you haven’t
tried the graphical software, or haven’t tried it lately, you will be surprised.

We also discovered that the short delay during initial application loads con-
tributed to users’ impressions of speed problems. When you start an applica-
tion like A/R or order entry, the system not only loads the programs into
memory, but also retrieves customized preferences for each user. While this
delay occurs only when you log on and go into an application for the first time
during a session, it creates an expectation of poor performance for some users.

So is graphical as fast as the text based software? It depends. Some tasks may
always be faster in text based, especially for people who have been using the
software so long that they have memorized the keystrokes. Other tasks are
clearly faster and easier in graphical. Also, graphical is much more hardware-
dependent; the amount of RAM in the server and workstations and the speed
of your hubs have a tremendous impact on system performance. For more in-
formation on system requirements, go to www.ddms.com/products/
win_requirements.htm

Order Entry
Many criticisms of the graphical software’s speed centered on order entry.
That’s not surprising, given this application’s importance in the typical
dealer’s business flow. Text based order entry may be faster for entering
simple orders. On the other hand, the graphical software includes many time-
saving features that are not available in text based.  That’s why you can run
text based order entry from within the graphical order entry window: you get
maximum efficiency for entering basic orders without the need for an addi-
tional user license, and you have the graphical version of order entry for view-
ing history, drilling down to item or order information, and so on. For addi-
tional advantages of graphical order entry, see Why Go Graphical? below.

Text AND Graphical
The choice of text or graphical has as much to do with personal preference as
actual software performance. That’s why the graphical software gives you
both, and not just in order entry. Almost every graphical application gives you
the option of using the text screens if you prefer…while still having the conve-
nience and ease-of-use offered by the Windows environment.
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Why Go Graphical?
“Okay,” you say. “You convinced me that any speed issues with graphical have been
resolved. As long as I have the right hardware, it should perform fine. But I’m happy
with the text based software I have now. Why go to the trouble of installing and learn-
ing graphical? Does it really offer me any advantages?”

Yes, there are definite advantages to graphical, and we believe the increased
efficiency will more than offset the transition costs over the long term. Here are
a few of them.

Legibility
With the graphical software, data is contained in defined fields. It’s easier and
faster to find and read information.

Training
The graphical software reduces training time. You can get new employees up
and running much more quickly in the Windows environment.

Using Keyboard or Mouse /It’s Your Choice
Many users told us they didn’t want to move to graphical because they didn’t
want to use a mouse to move around the window; a keyboard is faster, they
said. Again, this is a matter of preference. For an experienced user, a keyboard
can be faster. That’s why our graphical windows support keyboard shortcuts
for navigation and most system functions.

If you prefer to use the mouse, it’s your choice! You can use your mouse to
move around in any of the windows.

One User—Multiple Sessions
The graphical software allows you to work in multiple applications at the same
time. You can review a customer’s A/R history in one window while entering
a new order in another, for example. While our text based software for the
Microsoft® Windows and UNIX platforms allow this type of multi-tasking,
each open program (session) requires one user license. With graphical, you
only need one license per user, regardless of the number of applications.

Cutting and Pasting
The Windows environment lets you cut, copy and paste data from one field to
another. This saves time in creating records. For example, when creating a cus-
tomer ship-to record, you can copy relevant information like city or state from
the billing record instead of re-keying it.

Smart Windows
When using multiple applications, changes in one window can affect related
information displayed in another. For example, suppose you open a customer’s
master record in one window and the account history in another. Change to a
different customer record, and the history window automatically displays the
new customer’s account.
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User Preferences
Each graphical user can set his/her own preferences. If you have a furniture
operation and an office products operation, your order entry personnel can
view furniture order entry information or hide it from view.

You can add and remove buttons from the toolbars in the databases and appli-
cations.

You can also customize grids in almost every database or application. For ex-
ample, in A/R History in the A/R Detail tab, click the Set Grid Options but-
ton. You customize your grid by simply clicking the options you want to set.

Look-ups
Many of your operators probably have keystrokes and other information
memorized. But imagine the ease of looking up a salesperson’s number or a
tax district,  without having to remember it or look it up on a list that may or
may not be handy. See Figure 1.

You can look up information using almost any field in the system. You can
view history data and other detailed data from all the databases at the same
time.

Also, you can re-sort the information as needed. You can click on the button
that you want the information to sort by.

Drill-down menus are available throughout the system. For example, in Order
Entry, you select the action from a drill-down menu.

Scrollable Data Windows
Scrollable data windows means fewer errors and less to memorize.

You can scroll forwards and backwards through information.

Pop-up Windows
Pop-up windows display available choices for things like salesperson num-
bers, customer information, item information, and almost any other type of
data.

Figure 1:
Salesperson

Query
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Ease-of-Use
Ease-of-use was a major factor in developing the graphical software. It offers a
simpler, more consistent interface. The order entry window is a perfect ex-
ample. Changing a setting in the Global tab always affects the entire order,
while changes in the Item Detail tab affect only the selected line item.

Database Management
Creating and maintaining database records—customers, vendors, inventory,
etc.—is simply faster and easier in the graphical software. There’s no more
switching screens and tabbing through fields. Just click the box you want to
change, enter the data, and click “save.” Even if you keep on using text based
screens for everything else, the database management features justify the
switch to graphical.

Order Entry
Order Entry allows you to find information without ever leaving the applica-
tion. You can make changes quickly while online. You can quickly scan back
and forth during an order by simply clicking the tabs. When entering an order,
you can quickly change the salesperson or even the customer. Even if you’ve
entered several items on an order, you can still make global or line item
changes, such as changing the tax, for the entire order or for a line that has
been previously entered.

When you retrieve a customer in order entry, settings for that customer display
at the top of the window. In this example, this customer is set up for summary
billing. See Figure 2. You can access item detail or order totals at any time
while placing an order.

Figure 2:
Customer

Settings
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You can quickly look up customer item history without ever leaving your or-
der; just right-click on an item and view its history for this customer. You can
enter order notes and change order settings by simply pressing a function key.
Also, when changing or verifying items on an order, you can re-sort the infor-
mation as needed. You can sort by item description or company name, for ex-
ample.

You can release a quote in one easy step. You have the ability to view all or-
ders or quotes without having to know which number to query.

There are several ways you can move through the order entry fields. Pressing
Enter, Tab, or using your mouse will move you through the order entry
screens. Function keys and access keys are also available. For example, in the
Order Entry Global tab, type Alt + M to move the cursor directly to the Dept
Name field.

There are several ways to access order entry history. You can view customer
order history without ever leaving order entry simply by pressing F5. You can
view order entry history by clicking on the button at the top of the order entry
tab or by using access keys.

Multiple Order Entry Styles
DDMS software has always supported multiple types of order entry—com-
mercial, point-of-sale, furniture, machines, and so on. With the text based soft-
ware, this means switching between different screens. With our graphical soft-
ware, you’re always working in the same window. Just select the order type
from the drop-down menu, as shown in Figure 3, and the appropriate fields
and options for the selected order type open.

Figure 3:
Selecting Order

Entry Type
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Change, Verify, Delete Orders
In the Order Entry window, you can change, verify, and delete orders.

You can click on the Order Browse button to access all tickets that are available
to be verified, changed, or deleted, without having to perform a query. Press
the F11 key to display the Order Notes Window as you browse through the
tickets.

Order Changes
Our graphical software lets you easily change almost any component of an or-
der, including things that are impossible in text based. For example, suppose
you are ready to end the order and realize you retrieved the wrong departmen-
tal account. With graphical, you simply retrieve the correct department record,
then continue with the order. You can change line items by double-clicking or
by highlighting the item and pressing Enter. You can also scroll up or down by
clicking on the up or down arrow keys to access a line. Once the item is high-
lighted, press Enter to change the item.

Customer Deposits
The graphical software allows you to accept a deposit with the order. Deposits
are treated as liabilities for accounting purposes, and you have complete con-
trol over their management and application.

Third Party Billing
Third party billing allows you to bill a third party such as a leasing company,
while tying all order information to the actual end user for accurate manage-
ment and tracking of sales and customer history.

Order Settings Window
This window is easy to use and easy to understand. Simply press F6 and the
Order Settings dialog box opens. In this window, you can enter discount types,
who called, price breaks, contracts, and much more.

Figure 4:
Catalog Explorer
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Order Notes Window/Entering Specials
Order entry specials have never been easier. With the graphical software, all
you have to do is press the F11 key to display the Order Notes Window. Sepa-
rate fields let you enter text for beginning, ending, and line item specials. No
more special commands to remember and type. You can even select whether
the special text displays on the ticket, short-buy, backorder, or purchase order.

Ship-to Lookup
Looking up multiple shipto addresses and attentions is easier than ever. In or-
der entry, select the query button to display the complete list of shipto ad-
dresses. For a list of attentions for this customer, press Ctrl + A.

Catalog Search
The graphical software includes CD-ROM catalogs provided by major whole-
salers; such as United, SP Richards, and Techdata. See Figure 4. You can search
for items by item categories, wholesaler categories or catalog page numbers in
both order entry and purchasing. Click the desired item to add it to the order
or P/O. If the item is not in your inventory database, you have the option to
add it to your order as uncataloged.

Create P/Os from Order Entry
You can create purchase orders online with selected vendors directly from or-
der entry. This feature is available for dealers purchasing from a variety of
trading partners through thier private supply network (PSN). This feature al-
lows you to create and transmit the purchase orders automatically after the or-
der is entered.

Faxing and E-mailing
One button faxing and e-mailing is available from order entry and order entry
history. See Figure 5.

Figure 5: The O/E
History E-mail
Order Window
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Inventory
The Item database is easier than ever to use. You can view item pictures at the
click of a button. You can add manufacturers and wholesalers easily and
quickly. You no longer have to memorize keystrokes. Simply right-click on the
item  in the Vendors tab, as shown in Figure 6, and all the information can be
entered in one screen. Purchasing vendors are changed just as easily.

You can view item history from the Item database.

Vendors
eNsite Pro makes it quick and easy to add vendors in the Vendor window. You
can also add vendors during purchase order entry and accounts payable post-
ing.

Salespersons
There are new functions available in the Salesperson database. You can choose
by salesperson whether to use text based or graphical for order entry, purchas-
ing, accounts receivable, and accounts payable, as shown in Figure 7.

Maintaining your salesperson database is now much easier. With one click,
you can limit your salesperson to only have access to view database screens or
to only have the ability to process orders in order entry. See Figure 8.

Purchasing
In the Purchasing module, you can now run the short-buy report on screen.
You can view a list of items by vendor or change the vendor with one simple
click. You can change cost on-line and use all the purchasing functions from
one window.

Figure 6: Adding
Wholesalers and

Manufacturers
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A/R Posting
In the Accounts Receivable Posting window, you can easily mark and unmark
invoices when applying payments. You can view credits separately, and apply
or suppress credit amounts when applying payments. You can also suppress

Figure 8:
Salesperson

Allowable
Functions

Figure 7:
Restricting the
Salesperson to

Text Based
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zero balance invoices with just a click. When you apply checks to invoices, you
can let the system automatically mark the invoices based on department, date
of the statement, a range of pay dates, and long and short purchase order num-
bers.

Postings are not made to accounts receivable until you click the Post button.
This lets you mark the invoices, verify that all payments are correctly applied,
and make any necessary adjustments before posting. The A/R Invoice Selec-
tion dialog box is shown in Figure 9.

Another new feature lets you mark invoices that have been disputed. This al-
lows your A/R clerk to be aware of any invoices that are being disputed before
ever making a collection call.

What’s more, you can view and verify your A/R batch totals in the window
without the necessity of creating a report. From within the A/R window, you
can right-mouse-click on any invoice to view additional customer information,
order entry history, and accounts receivable history.

Once you open the invoice in order entry history, you can also view purchase
order entry history.

A/R History
The Accounts Receivable History window lets you easily view customer and
department information. You can see at a glance the customer’s invoices, check
numbers, payment dates and amounts, or any debit amounts. Since the infor-
mation is shown in columns, you can click the column heading to resort the
data, allowing you to easily find the information you need. For example, if you
click the Invoices column, you can sort invoices by invoice number, from high-
est to lowest. Similarly, by clicking the Payments column, you can sort the data
by payment amount.

Figure 9:  The
A/R Invoice

Selection Dialog
Box
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A/P Posting
Since you can mark and unmark invoices for payment, accounts payable
postings are easier than ever. Previously, you ran the To-Be-Paid report and
reviewed it before applying changes. Now changes are made before the checks
are released.

In the Accounts Payable Posting window, you can set limits for the vendors
whose invoices you want to pay. When you do, you can append and update
the AP-PAY file directly through the A/P window. You can even delete it, if
necessary.

Through the A/P Payment Limits dialog box, you can limit by vendor account
number, name, code, location, and date. See Figure 10. After the invoices are
displayed, you simply click the invoices you want to pay. You can also click
Recap by Vendor to verify the invoices you’ve marked.

Paying invoices by hand-written check is also much easier. You simply click
the Hand Check button and enter the vendor information, including the check
number. Then mark the invoices you want to pay. Postings are not made to ac-
counts payable until you are ready. If you change your mind, you can cancel
the transaction without posting anything.

Posting purchase orders has been made easier then ever by the addition of the
A/P Post P/O tab. You can use this tab to see every line item that has been
purchased but not posted against. You can also change the purchase order and
the invoice cost without leaving the A/P window.

While in the A/P window, you can also view additional vendor information,
purchase order entry history, and accounts payable history. Once you access
the P/O History window, you can view order entry history.

The Accounts Payable window lets you easily view A/P history information.
You can see at a glance the vendor’s invoices; payments and charges; invoice,
voucher, and net dates; check numbers; purchase order numbers; and much

Figure 10:  The
A/P Payment

Limits Dialog
Box
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more. Since the information is shown in columns, you can click the column
heading to resort the data, allowing you to easily find the information you
need. For example, if you click the Invoice # column, you can sort the dis-
played invoices by invoice number, from highest to lowest. Likewise, by click-
ing the Charges column, you can sort the data by charge amount. You can also
exclude zero balance invoices with a single click.

History
You can view all journals quickly and easily in O/E history, A/P history, A/R
history, and P/O history.

O/E History gives you online access to invoice history and item history. You
can view this information based on order number, dates, customer number, de-
partment, order-writer, salesperson, status, pay codes, back orders, and pur-
chase orders (short, long, or vendor). You can also look up various information
on items such as item number, description, company, quantity, sales, cost, or
margin.

In A/R and A/P History, you can easily access data by invoice number, pur-
chase order number, check number, date, payment amount or debit amount.

P/O History allows you to access purchasing information by  vendor number,
name, purchase order number, acknowledgment number, location, due date,
order date, and item number.

Graphical Status
As you know, we have been releasing graphical versions of our applications as
they are completed. Development began with the most frequently used appli-
cations, with more specialized modules coming later.

Online Help
Did you know that eNsite Pro both has complete online help? Help is always at
your fingertips. You can simply click the Help button at the top of each win-
dow or press F1 at any time. Besides the general help menu, you can also get
context sensitive help by placing your cursor in the box that you want a defini-
tion for, then press F1.

Cross Reference of Text Based Screens To Windows
You may find that older documentation refers to text based screens, such as the
(E) screen, for example, which performs the same function as its graphical
counterpart, the Item window. Or, you may find that you’re referenced to the
(AT) Tax Districts Tables screen, which in graphical software is located in the
View menu of the Customer window. The following reference list is designed
to help you find the right graphical software window when all you have is a
set of keystrokes for a text based screen name. For each text based screen name,
we list the screen title, and the directions to the equivalent graphical software
window. While there may be more than one way to get to a screen, this table
details the most common method.
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Code Text Screen Title Accessing the Graphical Equivalent

* Editor Text Based Only
! Word Processor Text Based Only
+ Specials Keyop Menu Icon >  Specials icon (text based)
? Planner Text Based Only
@ Printer Setup Text Based Only
& Faxing Program Faxing Icon
“ Contact Fax & E-Mail Customer Icon > View Menu > (Customers)
“ Contact Fax & E-Mail Salesperson Icon > View Menu > (Salesperson)
“ Contact Fax & E-Mail Vendor Icon > View Menu > (Vendors)
A Customer Master (main) Customer Icon > Master Tab

Customer Master (credit Customer Icon > Credit Tab
A limit & start limit)

Customer Master Customer Icon > Shipto/Attention Tab
A (shipping address)

Customer Monthly Customer Icon > View Menu > History > Monthly
AB Budgets Budgets Tab
AF Customer Credit Cards Customer Icon > View Menu > Credit Card
AG Customer Auto Billing Customer Icon > View Menu > Auto Bill

Customer History Customer Icon > Credit Tab
AH (A/R Information)

Customer History (MTD Customer Icon > View > History > Total Sales Tab
AH & YTD Sales)
AL Customer Buyers List Customer Icon > Buyers/Manifest Tab

Customer Service Quality Customer Icon > View Menu > History> Service
AQ Quality Tab
AQ Shipping Manifest Customer Icon > Buyers/Manifest Tab
AQ Summary Billing Customer Icon > Credit Tab
AQ E-Mail Category, Region, Customer Icon > Master Tab

& Area
AQ Exp. Sales $, of Emp. #, Customer Icon > View Menu> History > Total Sales

Exp. Margin $, Exp. G.P.% Tab
AR Customer Master Reindex Text Based Only
AS Customer Sales History Customer Icon > View Menu > History > Group Sales Tab
AT Tax Districts Tables Customer Icon > View Menu > Tax District

Customer Attentions Customer Icon > Shipto/Attention Tab
AX Cross Reference

(Attention & Shipto)
AX Customer Attentions Customer Icon > View Menu > Credit Cards

Cross Reference (Credit
Cards)

B Accounts Receivable Accounts Receivable Icon
Posting

BA Bad Account Number File Text Based Only
BB Batch Accounts Receivable Icon > Batch Totals
BC A/R Posting Change Accounts Receivable Icon > Post/Change Tab
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Code Text Screen Title Accessing the Graphical Equivalent

BE A/R E-Mail Statements A/R History Icon > Retrieve Customer > File > EMail
BF A/R Fax Statements A/R History Icon > Retrieve Customer > File > Fax
BI A/R Inquiry A/R History Icon
BO A/R Inquiry by PO # Accounts Receivable Icon > Post Change Tab
BP A/R Posting Accounts Receivable Icon > Post Change Tab
BQ A/R Check Posting Accounts Recievable Icon > Payments Tab
C Vendor Master Vendor Icon > Master/RemitTo/Account Status Tabs
CE Vendor EDI Parameters Text Based Only
CP Vendor Electronic Invoicing Vendor Icon > View Menu > Electronic Invoicing
CR Vendor Re-Indexing Text Based Only
CS Vendor PSN Vendor Icon > View Menu > Supply Options
CV Vendor Alias Vendor Icon > View Menu > Vendor Alias
CX Vendor Private Comm- Vendor Icon > View Menu > PCN

unication Network
DA Accounts Payable Accounts Payable Icon > AP Invoice Tab
DB A/P Auto Pay Text Based Only
DD A/P Discount Accounts Payable Icon > AP Invoice Tab > Retrieve

Invoice and Change Disc % > Post
DE Checks File Accounts Payable Icon > Action Menu >

Post to Check File
DI Accounts Payable Inquiry Accounts Payable History Icon
DM Accounts Payable Mark Accounts Payable Icon > Payments Tab > Setting

Invoices to Be Paid Limits
DO Accounts Payable Post P/O Accounts Payable Icon > Post P/O Tab
DP Accounts Payable Pay Accounts Payable Icon > Payments Tab > Handcheck

(Handcheck)
DT A/P Batch Totals Accounts Payable Icon > Batch Totals Tab
DV A/P Void Check Accounts Payable Icon > Action Menu > Void
E Inventory Master Item Icon > Master or Settings Tabs

(Master Record & Pricing
Record Fields)

E Inventory Master (Direct Item Icon > Vendors or Master Tab
Buy, Primary Wholesaler,
Purchasing Vendor)

E Inventory Master (Usage Item Icon > View Menu > History > Inventory Tab
Record)

E Inventory Master Item Icon > Settings Tab
(Mult Units of Measure)

EB Bill of Materials Link Item Icon > View Menu > Bill of Materials (text based)
EG Multiple Bins Item Icon > View Menu > Item Bins
EH Inventory History Item Icon > View Menu > History > History Tab
EK Bulk Item Update Screen Text Based Only
EL Customer Item Price Check Text Based Only
EN Inventory Remarks Item Icon > Remarks Tab
ER Inventory Re-Index Text Based Only
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Code Text Screen Title Accessing the Graphical Equivalent

ES Inventory Alias Item Databases > Item Alias
ET Inventory Contract Price Item Icon > View Menu > Inventory Contract (text based)
EV Vendor Contracts Item Icon > View Menu > Vendor Contracts (text based)
EX Item SIC Extended Desc Text Based Only
EZ Serialized Inventory Serialized Icon (text based)
E+/SPE Special Item Screen Keyop Menu Icon > Specials Icon > E (text based)
FC Purchase Order Change Purchase Order Entry Icon > Change Action Code
FD Purchase Order Delete Purchase Order Entry Icon > Delete Action Code
FE E-Mail Purchase Order P/O History Icon > Email P/O Icon
FF Fax Purchase Order P/O History Icon > Fax P/O Icon
FI P/O Inquiry P/O History Icon
FM Debit Memo Text Based Only
FO Purchase Order Entry Purchase Order Entry Icon > Order Action Code
FP Print Purchase Order P/O History Icon > Print Icon
FR Receive P/O Purchase Order Entry Icon > Pre-Receive or

(Pre-Receive & Final) Final ReceiveAction Code
FS Purchase Order Short Buy Purchase Order Entry Icon > Short-Buy Action Code
FT Purchase Order Transfer Purchase Order Entry Icon > Transfer Action Code
GA Order Entry (Auto Bill) Order Entry Icon > Auto Bill Action Code
GC Order Entry Change Order Entry Icon > Change Action Code
GD Order Entry Delete Order Entry Icon > Delete Action Code
GE EDI Release Text Based Only
GF Order Entry Fax O/E History Icon > Retrieve Invoice > File > Fax
GG Order Entry E-Mail O/E History Icon > Retrieve Invoice > File > Email
GI Order Entry Inquire O/E History Icon
GJ Journal Functions Text Based Only
GL Customer Price Check Text Based Only
GM Modify Quotes Order Entry Icon > Change Action Code
GO Order Entry (commercial) Order Entry Icon
GP Order Entry (retail) Order Entry Icon > Order Style > Retail
GQ Quotes Order Entry Icon > Pay Code > Quote
GR Order Entry Release Order Entry Icon > Release Action Code
GS Drop Ship Order Entry Text Based Only
GU Furniture Order Entry Order Entry Icon > Order Style > Furniture
GUT Furniture Project Furniture Project Management Icon

Management
GV Order Entry Verification Order Entry Icon > Initial or Final Verify Action Code
GX Credit Returns Order Entry Icon > Credit Action Code
HY Salesperson Master Salesperson Icon
HYF Salesperson Allowable Salesperson Icon > View Menu > Functions

Functions
HYL Salesperson Price Check Salesperson Icon > Price Check Tab

Parameters
HYP Remote Order Entry Salesperson Icon > Remote Order Tab

Parameters
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Code Text Screen Title Accessing the Graphical Equivalent

HYP1 Remote Order Entry Salesperson Icon > Addl./WinOrder Tab
Parameters

HYR Salesperson Re-Index Text Based Only
HN Personnel Master Personnel Icon (text based)
I Payroll Update Personnel Icon (text based)
J Chart of Accounts Master General Ledger Icon > Chart of Accounts Icon
K General Ledger Posting General Ledger Icon > GL Posting Icon
L Parameters Keyop Menu Icon > Parameters Icon (text based)
M Operational Procedures Keyop Menu Icon > Operational Procedures Icon

(text based)
N Custom Customer Reports Reports Menu Icon > Custom Customer (text based)
NR Standard Customer Reports Reports Menu Icon > Standard Customer (text based)
O Custom A/R Reports Reports Menu Icon > Custom A/R (text based)
OR Standard A/R Reports Reports Menu Icon > Standard A/R (text based)
P Custom Vendor Reports Reports Menu Icon > Custom Vendor (text based)
PR Standard Vendor Reports Reports Menu Icon > Standard Vendor (text based)
PD President’s Screen General Ledger Icon > President’s Screen Icon (text

based)
Q Custom A/P Reports Reports Menu Icon > Custom A/P (text based)
QR Standard A/P Reports Reports Menu Icon > Standard A/P (text based)
R Custom Inventory Reports Reports Menu Icon > Custom Inventory (text based)
RR Standard Inventory Reports Reports Menu Icon > Standard Inventory (text based)
S Custom P/O Reports Reports Menu Icon > Custom P/O (text based)
SG EDI Communication Text Based Only
SM Distribution Specialist Text Based Only

Custom Platform
SR Standard P/O Reports Reports Menu Icon > Standard P/O (text based)
T Custom O/E Reports Reports Menu Icon > Custom O/E (text based)
TD Print Shipping Labels Text Based Only
TM Picking Manifest Warehouse Icon > Picking Manifest Icon (text based)
TR Standard O/E Reports Reports Menu Icon > Standard O/E (text based)
TS Shiping Manifest Warehouse Icon > Shipping Manifest Icon (text based)
U Custom Sales Reports Reports Menu Icon > Custom Sales (text based)
UR Standard Sales Reports Reports Menu Icon > Stadard Sales (text based)
V Personnel/Payroll Reports Menu Icon > Personnel Reports (text based)
W General Ledger Reports Reports Menu Icon > G/L Reports (text based)
X Program Security Keyop Menu Icon > Program Security Icon (text based)
Z System Utilities Keyop Menu Icon > System Utilities Icon (text based)
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What’s an Icon?
In graphical user interfaces, an icon is a small picture with a label. In these in-
structions, an icon is in the master menu or application menus of your eNsite
Pro software.

When you double-click an icon, it launches a program. For instance, when you
are in the eNsite Pro master menu, and double-click the Reports Menu icon,
the Reports Menu appears. When you then click the Standard Customer Re-
ports icon, a new screen appears with a selection of standard customer reports.

What’s a Tab?
A tab may be a keystroke to take you to the next data field. However, in these
instructions, a tab is a clickable region of the screen that contains a screenful of
data fields or reports. It’s a way to conserve screen space within an applica-
tion, or to indicate the next stage in a task. For example, in Order Entry, there
are tabs for Global, Item Detail, and Order Totals, in the exact sequence you
must do to complete an order.

Where is View?
Menu bars are found along the top of DDMS eNsite Pro windows, between the
title bar and the toolbar row of buttons. When you click the menu name, a list
of options opens. Click the option you want and the appropriate action takes
place.

View is the title of one of these menus. For example, when you are in the Item
application, and click View on the menu bar, and select Item Bins, the Item
Bins window appears.

File and Action are other examples of menu titles.

What’s an Action Code?
In text-based software, most modules allow you to make some action (add a
record, inquire, change data, print, or view a related report etc.) by selecting a
single-letter code. This code is called the Action code. In these instructions,
you will often select the proper action code to take you to a specific screen or
begin a specific task.

Why is this marked (Text Based)?
Some features are available by going through the graphical software interface,
but actually open a terminal emulator window where you access text-based
software and interact with it using just the keyboard. For example, all Param-
eters are accessible by double-clicking Keyop Menu icon, then double-clicking
the Parameters icon, and typing the letters of the screen name.

Text Based Only
We have excluded directions where no equivalent graphical software window
exists. Some DDMS features are only available on the Text-Based platform. For
instance, the (!) Word Processor is a word processing application, like the
Microsoft Windows® Notepad. The functionality was not necessary to dupli-
cate in graphical software.



20 ECI² CONFIDENTIAL & PROPRIETARY

Parameters Menu
In text based you can find all of the parameters in the (L) Parameters
screen.Parameters have not yet been programmed in graphical, but are acces-
sible from graphical screens in eNsite Pro.

To get to any parameter screen through graphical software, simply click the
Keyop Menu icon, then the Parameters icon. This will open up a text based
window and take you to the (L) Parameters screen, where you can type the pa-
rameter screen code you wish to go to.

For example: If you wanted the (LG5) Commercial Order Entry Parameters,
you would click on the Keyop Menu icon and the Parameters icon. In the Pa-
rameters screen, you would type G5.

Reports
Like Parameters screens, DDMS reports also have not been programmed in
graphical. However, you can get to any report through graphical screens in
eNsite Pro. There are two types of reports.

There is what we call Custom reports (or customizable) which are in screens
(N) through (U) — note the single-letter codes.

Each custom report screen has a corresponding Standard report screen of hard
coded reports. Standard reports are in screens (NR) through (UR) — note the
two-letter codes.

You also have (V) Personnel / Payroll and (W) G/L reports.

To get to these screens in eNsite Pro, you would double-click the Reports Menu
icon and then the icon for the Custom or Standard report you wanted to go to.

For example, if you wanted to go to the (NR) Customer Standard Reports you
would double-click the Reports Menu icon and then the Standard Customer
icon.

If you wanted to go to (N) Custom Customer Reports, you would double-click
the Reports Menu icon and then the Custom Customer Reports icon.
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